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TO:  FALL 2021 Curriculum Committee  

FROM: Thomas Eaton, Chair, Department of Art 

DATE:  September 20, 2021 

RE: Change in Pathways Submission Group for ART 2400 – Global Contemporary 

Art: Diversities and New Expressions 

The Department of Art is proposing a change to the Pathways Submission Group for ART 2400 - 
Global Contemporary Art: Diversities and New Expressions. 

 

FROM:   

World Cultures and Global Issues (Group A) 

TO: 

Creative Expression (Group C) 

 

Rationale for Change: 

An initial submission to the CUNY Common Core Review Committee (CCCRC) required 
revision where it was suggested that the course aligned better with the Pathways Learning 
Outcomes for Creative Expression (Group C) rather than World Cultures and Global Issues 
(Group A).  After review, it was determined that the course did indeed better aligned with 
Creative Expression.  We are now asking that the Curriculum Committee approve submission to 
this Flexible Core group.   
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CUNY Common Core  
Course Submission Form  

Instructions: All courses submitted for the Common Core must be liberal arts courses. Courses submitted to the Course Review Committee may be 
submitted for only one area of the Common Core and must be 3 credits.  Colleges may submit courses to the Course Review Committee before or 
after they receive college approval. STEM waiver courses do not need to be approved by the Course Review Committee. This form should not be 
used for STEM waiver courses. 	

College KINGSBOROUGH COMMUNITY COLLEGE 
Course Prefix and 
Number (e.g., ANTH 101, 
if number not assigned, 
enter XXX) 

ART 2400 

Course Title Global Contemporary Art 
Department(s) ART 
Discipline ART HISTORY 
Credits 3 
Contact Hours 3 
Pre-requisites (if none, 
enter N/A) 

NONE 

Co-requisites (if none, 
enter N/A) 

N/A 

Catalogue Description 
 
 
 

This class introduces global contemporary art (the arts in the Americas, Europe, the Middle East, 
Asia, and Africa) since 1970. The Cold War and US intervention in the Vietnam War triggered 
people’s distrust in institutional and ideological forms of knowledge. The class begins by 
examining how this shift transformed the artistic style in New York during the 1970s and 80s, and 
broadened the scope of art by including underrepresented women and Cultural Other. After the 
collapse of the Berlin Wall (1989), the art world expanded beyond Euroamerica. The course 
examines how art unfolded during and after the Cold War, conceiving it not only along the 
communist/capitalist ideological divide, but also as the incubator of the new global power structure, 
which resulted in the artistic responses to dictatorship, climate change, ethnic cleansing, gender 
discrimination, postcolonial identity, racial segregation, and war in the Global South. The course 
ends with examining inter-cultural connectivity by looking at the latest artistic developments in 
North America and Europe. 
 

Special Features (e.g., 
linked courses) 

 
 

Sample Syllabus  ART_2400_SYLLABUS.PDF. 

 
Indicate the status of this course being nominated: 

 
 current course    þ revision of current course     a new course being proposed 

 
CUNY COMMON CORE Location   

 
Please check below the area of the Common Core for which the course is being submitted. (Select only one.) 

 
    Required Core 
 

 English Composition 
 Mathematical and Quantitative Reasoning 
 Life and Physical Sciences 

 
    Flexible Core 
 

 World Cultures and Global Issues (A)       
 US Experience in its Diversity (B)                       

þ Creative Expression (C)                         
 Individual and Society (D)                                 
 Scientific World (E) 

 



	 	 4	

	

 
B. U.S. Experience in its Diversity 
 
A Flexible Core course must meet the three learning outcomes in the right column. 
 
 
 • Gather, interpret, and assess information from a variety of sources and points of 

view.  
 • Evaluate evidence and arguments critically or analytically.  
 • Produce well-reasoned written or oral arguments using evidence to support 

conclusions. 
 
A course in this area (II.B) must meet at least three of the additional learning outcomes in the right column. A student will: 
 
 • Identify and apply the fundamental concepts and methods of a discipline or 

interdisciplinary field exploring the U.S. experience in its diversity, including, but 
not limited to, anthropology, communications, cultural studies, economics, history, 
political science, psychology, public affairs, sociology, and U.S. literature.  

 • Analyze and explain one or more major themes of U.S. history from more than 
one informed perspective.  

 • Evaluate how indigenous populations, slavery, or immigration have shaped the 
development of the United States.  

 • Explain and evaluate the role of the United States in international relations.  
 • Identify and differentiate among the legislative, judicial, and executive branches of 

government and analyze their influence on the development of U.S. democracy.  
 • Analyze and discuss common institutions or patterns of life in contemporary U.S. 

society and how they influence, or are influenced by, race, ethnicity, class, 
gender, sexual orientation, belief, or other forms of social differentiation. 
 

 
C. Creative Expression 
 
 
A Flexible Core course must meet the three learning outcomes in the right column. 
 
Students	will	gather	multiple	primary	and	secondary	
sources	to	complete	the	course's	high-stakes	writing	
projects	(FORMAL	PAPER):	this	is	a	research	project.	
Students	will	select	their	own	objects	of	study	for	their	
primary	text	argument	work	from NYC’s contemporary art 
museums (MoMA PS1, MoMA, New Museum, Whitney, etc.). 
They will	conduct	secondary	academic	research	on	both	
their	self-selected	object/s.		
	
Most	importantly,	this	class	centers	on	visual	
observation.	Students	will	get	trained	with	the	slide	
lecture,	and	with	the	reflective	writing	in	reading	
summaries	and	low-stake	discussion	board	
assignments.	These	weekly	training	and	group	
discussions	on	the	discussion	board	will	encourage	
students	to	approach	objects	from	multiple	points	of	
view.	In	class,	students	will	demonstrate	their	ability	to	
do	this	work	on	their	own,	and	through	primary	and	
secondary	research.	Five	low-stakes	discussion	board	
writing	assignments	and	the	exchange	of	opinion,	and	
three	article	summary	and	reflection	will	require	

• Gather, interpret, and assess information from a variety of sources and points of 
view.  
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students	to	demonstrate	the	ability	to	look	at	texts	and	
objects	through	various	perspectives.	
	
Students	will	read	a	wide	range	of	writings	from	
perspectives	such	as	the	following:	feminism,	eco-
criticism,	Islamic,	information	theory,	Marxist,	Etc.,	in	
each	relevant	unit,	as	marked	on	the	syllabus,	and	will	
be	asked	to	critically	interpret	and	analyze	their	central	
arguments.	For	all	formal	and	informal	assignments,	
students	will	be	asked	to	explain,	evaluate,	and	apply	
the	tenets	of	each	worldview	to	a	variety	of	art	objects	
in	a	variety	of	ways.	While	several	objects	of	artistic	
study	and	perspectives	on	social	milieu	will	be	selected	
by	the	instructor,	students	will	be	asked	to	pick	
relevant	critical	approach	to	the	objects,	and	to	
present	it	in	the	class	for	the	class	discussions.	These	
projects	require	that	students	demonstrate	the	ability	
to	evaluate	evidence	and	arguments	critically	and	
analytically.	
	

• Evaluate evidence and arguments critically or analytically.  

Formal	writing	assignments	require	students	to	craft	
thesis-driven,	self-designed	arguments.	In	it,	students	
will	be	expected	to	work	carefully	with	claims,	
evidence,	and	warrant	(taught	carefully	in	a	process	of	
scaffolding	in	the	writing	assignments	and	reinforced	in	
named,	isolated	parts	on	the	grading	rubrics)	in	order	
to	carefully	support	their	thesis.	They	will	achieve	this	
through	three	scaffolding	writing	process	in	four	formal	
papers.	In	class,	they	will	be	frequently	asked	to	make	
a	comparative	analysis	of	two	objects	and	asked	to	
create	a	well-supported	argument.	These	exercises	will	
help	them	to	demonstrate	well-reasoned	written	
arguments	through	the	use	of	evidence	to	support	
their	conclusions.	
	

• Produce well-reasoned written or oral arguments using evidence to support 
conclusions.  
 

 
A course in this area (II.C) must meet at least three of the additional learning outcomes in the right column. A student will: 
 
By	analyzing	contemporary	art	from	three	major	
categories--Appropriation,	Cultural	Hybridity,	and	the	
arts	dealing	with	Social	Issues	for	equity—defined	in	
WEEK	2,	students	will	first	identify	these	fundamental	
concepts	when	they	look	at	contemporary	art,	then	
apply	psychological,	philosophical,	and	social	
theories/frameworks	to	various	forms	of	contemporary	
art.	They	will	examine	artworks	through	a	variety	of	
background	from	different	areas	on	the	globe	that	
relates	to	the	historical	background	of	the	Cold	War.		
	
Based	on	Terry	Smith's	textbook,	Contemporary	Art:	
World	Currents,	Smith	defines	contemporary	art	in	

• Identify and apply the fundamental concepts and methods of a discipline or 
interdisciplinary field exploring creative expression, including, but not limited to, 
arts, communications, creative writing, media arts, music, and theater.  
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relation	to	the	Cold	War.	The	collapse	of	the	Berlin	
Wall	in	1989	globalized	the	art	world.	However,	it	is	
also	true	that	the	arts	made	in	and	after	1989	
continued	from	the	previous	period.	This	course	begins	
by	studying	the	stylistic	changes	in	arts	around	1970.	
This	change	occurred	when	the	anti-Vietnam	War	
sentiments	triggered	youths’	skepticism	against	the	
institutional	and	ideological	form	of	knowledge,	gave	
rise	to	the	“emancipation	narrative,”	which	shed	light	
on	the	historically	oppressed	women	and	culturally	
under-represented	ethnic	and	racial	minority	artists.	
The	course	is	interdisciplinary	with	history	and	modern	
intellectual	history.	Students	will	examine	how	this	
shift	in	the	intellectual	history	reflected	in	the	
formation	of	visual	arts	in	“appropriation,”	“multi-
culturalism,”	and	“social	significance	of	art,”	using	an	
easily	digestible	education	video	(click	HERE).	After	
learning	about	the	stylistic	shift	in	art,	students	will	
learn	feminism,	multi-culturalism,	AIDS	activism,	and	
housing	activism,	based	in	New	York—the	world’s	
cultural	center.	They	will	think	about	these	
interdisciplinary	topics	that	they	face	every	day	
through	analyzing	how	artists	responding	to	these	
topics.		
	
After	1989,	the	New	York	art	scene	becomes	
globalized.	The	course	examines	the	Cold	War	as	of	the	
communist/capitalist	ideological	divide	and	also	as	a	
process	of	establishing	the	new	global	power	structure	
under	accelerated	capitalism.	After	examining	the	arts	
from	the	former	Eastern	bloc,	the	latter	half	of	the	
class	will	examine	how	this	new	global	power	
relationship	affected	the	cultural	representations	in	the	
Global	South	(including	parts	of	Asia,	the	Americas,	the	
Middle	East,	and	Africa).		
	
Students	will	critically	analyze	arts	by	historically	
oppressed	women	and	culturally	under-represented	
racial	and	ethnic	groups,	incorporating	a	variety	of	
disciplines,	such	as	feminism,	housing	insecurities,	and	
historical/economic	conditions	in	the	global	south.	
These	are	the	issue	close	to	our	students	as	70.3	
percent	of	Kingsborough	students	are	minorities;	its	
racial	make-up	predominantly	black	(35.8%	Black,	
18.2%	Hispanic,	16.3%	Asian). 
	 • Analyze how arts from diverse cultures of the past serve as a foundation for those 

of the present, and describe the significance of works of art in the societies that 
created them.  

Applying	feminism	and	other	theories	to	a	variety	of	
contemporary	arts	and	think	how	social	and	political	
milieus	shaped	creative	forms,	students	will	learn	to	
argue	for	multiple	analyses	of	each	artwork's	

• Articulate how meaning is created in the arts or communications and how 
experience is interpreted and conveyed.  
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significance	depending	upon	the	worldview	of	both	the	
artist	and	the	audience.	They	will	also	learn	to	argue	
for	how	form	and	genre	play	an	explicit	role	in	shaping	
meaning.	As	part	of	their	arguments	about	these	
artworks,	students	will	conduct	primary	and	secondary	
research	on	their	self-selected	objects	of	artistic	study.	
	
Through	genre	and	form	analysis	(as	the	course	will	
cover	a	wide	variety	such	as,	but	not	limited	to	video,	
photography,	sculpture,	painting,	multimedia,	
conceptual	texts,	visual	texts	etc.)	students	will	learn	to	
identify	and	discuss	craft	elements	implemented	by	the	
creators	of	these	objects	of	study.	In	their	formal	
writing,	students	will	be	expected	to	use	skill-
vocabulary	in	order	to	articulate	their	analyses	of	each	
piece	of	creative	expression.	
	

• Demonstrate knowledge of the skills involved in the creative process.  

For	this	class,	students	need	to	communicate	with	their	
classmate	and	the	instructor	constantly	using	
Blackboard.	How	to	use	Blackboard	will	be	taught	in	
the	beginning	of	the	semester	zoom	session	
(recording).	Students	will	also	need	to	consult	their	
research	direction	with	a	librarian	Mark	Eaton	to	land	
on	the	right	sources.		

• Use appropriate technologies to conduct research and to communicate. 
 



 
Kingsborough Community College 
of the City University of New York 

Department of Art 
Art2400-02 [63561], Global Contemporary Art 

September 9~December 16, 2021 
Syllabus 

 
HYBRID: MEETING THURSDAYS 11:30-1 PM (S-136) 
ONLINE SYNCHRONOUS TUESDAYS 11:30-1 PM 
WRITING INTENSIVE 
Instructor: Midori Yamamura, Ph.D.  E-mail: Midori.Yamamura@kbcc.cuny.edu  
Office hours: Mon-Wednesday, 15:00-16:00 am, and by appointment 
Virtual Office: Zoom, Blackboard Ultra, or by Phone  Phone: (917) 972-2944 
The Instructor Alternative E-mail:  myamamura3524@gmail.com 
3 Credits, 3 Hours.  Pre-Requisites:  None. Co-requisites:  None. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Course	Description:	This class introduces global contemporary art (the arts in the Americas, 
Europe, the Middle East, Asia, and Africa) since 1970. The Cold War and US intervention in the 
Vietnam War triggered people’s distrust in institutional and ideological forms of knowledge. The 
class begins by examining how this shift transformed the artistic style in New York during the 
1970s and 80s, and broadened the scope of art by including underrepresented women and 
Cultural Other. After the collapse of the Berlin Wall (1989), the art world expanded beyond 
Euroamerica. The course examines how art unfolded during and after the Cold War, conceiving 
it not only along the communist/capitalist ideological divide, but also as the incubator of the new 
global power structure, which resulted in the artistic responses to dictatorship, climate change, 
ethnic cleansing, gender discrimination, postcolonial identity, racial segregation, and war in the 
Global South. The course ends with examining inter-cultural connectivity by looking at the latest 
artistic developments in North America and Europe.	
 
Learning Objectives/Outcomes  
 
After taking this  course: 

• Students will have basic knowledge and understandings about global contemporary art. 
• Students will become aware of the issue artists face in contemporary society 
• Students can apply basic knowledge about contemporary art and will be able to analyze, 

evaluate, and creatively write about contemporary concerns that artists are facing. 
• Based on the knowledge they acquired, students can evaluate contemporary art on their own. 

 

 
 

Citizen artist Carrie 
Mae Weems Launches 
Resist COVID Take 6 
Click Here to read about 
this project  



Course Organization 
 
The course consists of three sections: 1) Learning about the basic ideas of contemporary art; 2) How 
artists grappled with contemporary issues, taken an example in New York City; 3) Expanding 
contemporary art into a global scale.  
 
Weekly  Module Structure 
 
On the left  s ide of  B lackboard,  you wil l  f ind “Course Content.” Submit  discussion 
through “Discussions” 
Synchronous c lass  wi l l  be held in  “Blackboard Ultra.”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
C l ick  on it ,  you wil l  see the f i les:  Syl labus,  Writ ing Samples,  and Weekly fo lders. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*Synchronous Class:  Class meets virtually at a specific time 
*Hybrid Face-to-Face: Meeting will be held at S-136, KBCC on Thursdays, 11:30-1 pm.  
 
Use of  Writ ing Center 
TBA 
  

 

 



 
Readings:   
This class uses an Open Educational Resource (OER) class. All OER readings are online. You can access 
through an interact ive syl labus.  You will find a clickable links to the reading under the assigned week 
module. 
The same link can be found in the weekly folder and on the ppt. 
 
Other readings 
OVERVIEW 
Smith, Terry. Contemporary Art: World Currents. NJ: Prentice-Hall, 2011.  

- Hard copy: $95.15, Rental $21.34 (Amazon) 
- The course will also use the Open Educational Resource (OER) 

 
Course readings 

- Choi, Chungmoo. “The Minjung Culture Movement and the Construction of Popular Culture 
in Korea,” in South Korea’s Minjung Movement: The Culture and Politics of 
Dissidence (Honolulu: University of Hawai’i Press, 1995), 105-118. 

- Gregory, Alice. “Anicka Yi is Inventing a New Conceptual Art,” The New York Times Style 
Magazine, February 14. 2017.  

- Khatchadourian, Read Raffi. “The Art of Return: Through playful, outraged interventions, 
Michael Rakowitz seeks to reclaim a lost Iraq,” The New Yorker (August 24, 
2020): 46-55. 

- Li, YuChieh and Midori Yamamura, eds. Visual Representation and the Cold War: Art and 
Postcolonial Struggles in East and Southeast Asia. (Routledge, 2021) 

- Nochlin, Linda. “Why Have There Been No Great Women Artists?” (1971). U. Penn, Open 
Education Resource. Click Here. 

- Yamamura, Midori. “Chapter 1: Delicious Life.” Unpublished manuscript for Japanese Art 
Since 1989: Emergence of the Local in the Age of Globalization. 

-   . “Archetypes: Cordillera’s Labyrinth.” Antennae 55 (Summer 2021): 122-139. 
 
Assignments:  
 
Weekly Quizzes:    40% (8 multiple choice questions) 
Final Exam   10% (Essay question) 
Writing Components: 
Informal Writing   15% (Five discussion board participations) 
Formal Paper   35% (Three stage/scaffolding writing 
 
Grading Scale (your grade will be posted on Blackboard grade section) 
A+ 97-100 / A 93-96 / A- 90-92 / B+ 87-89 / B 83-86 / B- 80-82 / C+ 77-79 / C 73-76 / C- 70-72 
/ D+ 67-69 / D 63-66 / F 62 or below 
 
Blackboard Access: You must access blackboard regularly. See the help desk at L-106 for 
assistance. 
 
Email Access: You must email me from your KCC email address and check it regularly. See the 
help desk at L-106 for assistance. 
  



Course Topical Outline:  
 
WEEK1: IW1/Q1 

A. Introduction to Blackboard:  
- Register email address/send an alternative email address to the instructor 
- Going over the syllabus and assignments 

 
Assignment 

• Informal Writing (IW) 1, Discussion Board Opinion Exchange: Instead of self-introduction, 
watch a video from 2014 (contemporary art) Uneven Growth. Click Here. Write what you thought 
about the video piece. Think: Why the artist creates the work like this one. What is his purpose? 
After posting your thoughts, make comments on at least 2 peer postings. 

 
B. Modernism: The Age of Isms  

- Watch the video: "Introduction to Twentieth-Century Art." Click Here. 
- Read: “Becoming Modern.” Click Here. 
- Read: “Modernism and its legacy.” Tate, 2015. Click Here.  

 
PPT: Cubism, Expressionism, Dada, Surrealism, Abstract Expressionism, Social Realism, Pop Art, 
Minimalism, Conceptual Art, Land Art 
 
Assignment 

• Quiz 1 (Q1): Major Terms and Movements in Modern Art 
 
WEEK 2: Q2/IW2 

A. What is Postmodernism? Three Major Ideas: Appropriation, Cultural Hybridity, and the arts 
dealing with Social Issues for equity 
- Watch the video: "Introduction to Contemporary Art." Click Here. 
- The Picture Generation: Click Here. 

 
Closer Look (All “Closer Look” links are embedded in the slides): 
The Picture Generation, appropriation in NY, and its transfer in London:  
Read and take notes: “Sherrie Levine, Untitled (after Edward Weston, ca. 1925)” "Jeff Koons, Pink 
Panther," "The YBAs, The London-Based Young British Artists," “Damien Hirst, The Physical 
Impossibility of Death in the Mind of Someone Living.” 
Historically under-represented artists 
 “Chris Ofili, The Holy Virgin Mary,” “Tracy Emin, My Bed.” 
 
Assignment 

• Q2: Three Major Ideas of Postmodernism 
 

B. Historically Underserved Artists Revisiting Histories:  
 
Closer Look (All “Closer Look” links are embedded in the slides): 
“Nari Ward, ‘We the People,’” “Kerry James Marshall Interview,” “Kara Walker, PBS Culture Shock,” 
“Meet Jaune Quick-to-See Smith,” “Wendy Red Star, 1880 Crow Peace Delegation,” “Alison Saar, Topsy 
and the Golden Fleece,” “Roger Shimomura, Superman, World War II, and Japanese-American 
experience,” “Carrie Mae Weems on her series “From Here I Saw What Happened and I Cried.’ ” 

 
Assignment: 

• IW 2, Discussion Board Opinion Exchange: Communicate in writing, your thoughts about 
postmodernism. Make comments on at least 2 peer postings. 

 
WEEK3: FP1, AD1 

A. How did Artists Arrived at the Postmodern Era in Circa 1970: Feminist Art, Shifting the 
World-Order  
- Unlock Art: Where are the Women? Click Here.  
- Nochlin, Linda. “Why Have There Been No Great Women Artists?” (1971). Click Here 

 
Closer Look, Women’s Work/Women’s Body: What are they trying to tell us? 
“Mierle Laderman Ukeles, Washing/Tracks/Maintenance: Outside (July 23, 1973),” “Mary Kelly, Post-



Partum Document,” “Eleanor Antin, Carving: A Traditional Sculpture,” “Martha Rosler invented the 
Semiotics of the Kitchen,” “Dinner Party at the Brooklyn Museum,” “Carolee Schneemann, Interior 
Scroll (1975),” “Hannah Wilke, S.O.S. – Starification Object Series 1974-82,” “Guerilla Girls.” Yoko 
Ono, Cut Piece. Click Here. 
 
Assignment:  

• Article Discussion (AD1): Extra credit: Summary, analysis, and reflection on Nochlin’s essay 
 

B. Multi Culturalism in the Lower East Side/Art in the Age of AIDS 
 
Closer Look (All “Closer Look” links are embedded in the slides): 
Multi Culturalism in the Lower East Side: 
“David Hammons: African-American Flag,” New sculpture at the pier across the Whitney: “Day’s End by 
David Hammons,” “Jimmie Durham,” “Martin Wong.” 
 
AIDS-Related Art: 
“Felix Gonzalez-Torres, Untitled (Billboard of Empty Bed),” “Sue Coe, Aids won’t wait, the enemy is 
here not in Kuwait,” “Jean-Michel Basquiat, Horn Players,” “Keith Haring, Subway Drawings.”   
 
Assignment: 

• Final Paper (FP) 1: By this class, you must visit at least one contemporary art museum or a 
recommended exhibition (listed on Blackboard). Select one work that interests you. Using a free-
flowing form, write down your first impression of the artwork at the gallery or museum. Do some 
research on the artist and the artwork(s), type out a paragraph that explains what you will be 
writing about. Submit the paper on Blackboard, using the assignment link (Assignment Folder).  

 
WEEK 4: IW3&4, Mock debate,  The goal for this section is to make students understand how artists 
incorporate the most pressing issue that we encounter daily. Subject for this section can be 
interchangeable  

A. How Do Artists Introduce Contemporary Concerns in Art? Art and Housing Crisis 
- Raffi Khatchadourian, “The Art of Return: Through playful, outraged interventions, Michael 

Rakowitz seeks to reclaim a lost Iraq,” The New Yorker (August 24, 2020): 46-55. 
 
Closer Look (All “Closer Look” links are embedded in the slides): 
“Interview with Martha Rosler, The Artist who Speaks Softly but Carries a Big Shtick,” “Hope Sandrow, 
Artist Homeless Shelter Collaborate,” “Michael Rakowitz, paraSITE,” 
“Krzysztof Wodiczko, Homeless Vehicle (1988-89)” 
 
Assignments: 
IW 3, Discussion Board Opinion Exchange:  

- Read two reviews written from two different perspectives. Write on the discussion board 
which argument you support and why, or if you have your own thoughts, please write that 
down. Go over peer postings and comment at least two. 

Readings (Mock debate): 
- Hypereallergic, “Andres Serrano, show us how not to help the homeless.” Click Here. 

ARTNET, “Andres Serrano Wants New Yorkers to Stop Ignoring the Homeless.” Click Here. 
Assignment 2 (digital literacy):  

- Anti-Eviction Mapping Project, Click Here. Explore the NY segment of Anti-Eviction 
Mapping Project. 

 
B. Guest Speaker (this may be in a form of ZOOM recording from an OER source) 

Manon Vergerio, the founder of Anti-Eviction Mapping NY Chapter:  
 
Assignments: 
Informal Writing 4, Discussion Board Opinion Exchange:  
Write your opinion about Manon’s talk. Were you excited about her presentation? 

What can you learn from the real world? How can you use your research in the humanities topic 
to make difference in the world? Was her use of visual elements as communication tool 
convincing? Go over peer postings and comment at least two. 
 

WEEK 5: Q3 



A. The Fall of Communism in the Former Eastern Sector: (Russia, East Europe, and China)  
TEXTBOOK: Ch. 3. Russia and (East of) Europe 
 
Closer Look (All “Closer Look” links are embedded in the slides): 
Post-WWII Germany, Co-opting with the war’s trauma 
“Gerhard Richter, September by Robert Storr,” “Anselm Kiefer, Bohemia Lies by the Sea,” 
“Joseph Beuys, I Like America and America Likes Me,” 
 
Russia and (East of) Europe 
Boris Mikhailov, Ilya and Emilia Kabakov, Marina Abramovic, Krzysztof Wodiczko,   
 

B. China and North Korea 
TEXTBOOK: Ch. 5. 150-167. 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
“The Case of Ai Weiwei,” “Xu Bing, Book from the Sky.” 
 
Assignment 
Q 3 
 
WEEK 6: Q4, R2 

A. Circa 1989: Art World Becomes Globalized 
- “Exhibition Histories, Magiciens de la terre." 

Korea: 
Textbook: Ch. 5. 171-73 
Choi, Chungmoo. “The Minjung Culture Movement and the Construction of Popular Culture in Korea,” 
in South Korea’s Minjung Movement: The Culture and Politics of Dissidence (Honolulu: University of 
Hawai’i Press, 1995), 105-118. 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
 “Nam June Paik, Electronic Superhighway: Continental U.S., Alaska, Hawaii,”  
 “Do Ho Suh, Rubbing/Loving,” 
 “Anicka Yi, Guggenheim” 
  Optional: “Anicka Yi is Inventing a New Conceptual Art,”  
 

B. Japanese Art after 1989 
- Midori Yamamura, “Delicious Life,” Unpublished Manuscript, Japanese Art Sincee 1989: 

Emergence of the Local in the Age of Globalization. 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
 Hiroshima-Nagasaki Atomic Bomb Exhibit,  
 The Hysteria of this flower, Takashi Murakami 
 “Chim↑Pom | Super Rat.” 
  “Mariko Mori Pure Land.” 
 
Assignment 
Q 4 
R2: Extra-Credit: Response paper, Prof. Yamamura’s book chapter 
  
WEEK 7: IW5, FP2 

A. Southeast Asia: The Philippines, Postcolonial Art/Indigenous Wisdoms 
- YuChieh Li and Midori Yamamura, “Introduction: Locating Asian art in the Cold War,” 

Visual Representation and the Cold War: Art and Postcolonial Struggles in East and 
Southeast Asia (Routledge, 2021). 

- Optional: Yamamura, Midori. “Asia’s Cold War and Environmental Devastation: Kidlat 
Tahimik and Roberto Villanueva’s Neo-Indigenous Responses.” Chapter 4 of Visual 
Representation and the Cold War: Art and Postcolonial Struggles in East and Southeast Asia 
(Routledge, 2021). The section on Perfumed Nightmare.  Click Here: 
 

Screening: Kidlat Tahimik, dir. Perfumed Nightmare (1977) 



 
Assignment 
Informal Writing 5, Discussion Board Opinion Exchange:  
Reflection on Tahimik’s film. What did “perfumed nightmare” represent? Did you notice some aspects of 
the Cold War in the film? If so, how did it influence Kidlat’s life? 
 

B. South and Southeast Asia: Traditions, War, Genocide, Overused Resources: 
Southeast Asia:  
Textbook: Ch. 5. 
- Katherine Burnett, “Montien Boonma: Temple of the Mind,” Caa. Reviews, 2004 
- Midori Yamamura, “Archetypes: Cordillera’s Labyrinth.” Antennae 55 (Summer 2021): 122-

139. 
 
Closer Look (All “Closer Look” links are embedded in the slides):  

- Dinh Q Lê, Dinh Q Lê, Agent Orange Aftermath 
- FX Harsono, Nalini Malani, Transgressions, Sophaep Pich 

 
Assignment: 

• Final Paper 2: Incorporate the instructor’s suggestions and do research, complete the first draft 
of your final paper. Submit the paper on Blackboard, using the assignment link (Assignment 
Folder).  

 
WEEK 8: R2, Q5 

A. Oceania 
Textbook: Ch. 7. 
Russell Storer, “Imagining a region: Australian exhibitionary turns to Asia in the late Cold War,” in Li 
and Yamamura eds., Visual Representation and the Cold War: Art and Postcolonial Struggles in East and 
Southeast Asia (Routledge, 2021). 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
 Johnny Warangkula 
 Tracey Moffatt 
 
Assignment 
Extra Credit: Reflection paper on Storer’s chapter 
 

B. Political Unrest: The Arts in the Middle East 
Textbook: Ch. 9 
Watch: Conflict in Israeli and Palestine: Click Here. 
Read: The Middle East and the End of Empire 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
 Shirin Neshat, Rebellious Silence, Women of Allah series 
 Emily Jacir at the Venice Biennale 
 “Mona Hatoum at Tate Modern.”  
 Sigalit Landau 
 
Assignment 
Quiz 5 
 
WEEK 9: Q6 
 A&B. Contemporary Africa: Decolonizing Struggles 
Textbook: Ch. 8 
African Decolonization Explained 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
Central Africa 
 Congo 
 Bodys Isek Kingelez 
 Bodys Isek kingelez, City Dreams 
South Africa 



 Apartheid (history) 
 Sue Williamson, For Thirty Years Next to His Heart 
 William Kentridge, Drawing from Tide Table 
West Africa 
 Ghana 
 Resisting Colonialism-Through a Ghanaian Lens (history) 
 El Anatsui, Untitled 
 Paa Joe’s Coffin in the Form of Nike Sneaker 
 Mali 
 Seydou Keita 
East Africa 
 Ethiopia 
 Julie Mehretu, Stadia II 
 Kenya 
 Wengechi Mutu, Preying Mantra 
North Africa 
 Egypt 
 Ghada Amer 
 
Assignment 
Quiz 6 
 
WEEK 10: Q9, F3 
 A&B. Multiple Modernisms: South and Central America, the Caribbean 
Textbook: Ch. 4 South and Central America, the Caribbean 
Readings and Videos  
           Latin American Independence movements, 1450-present 
           Introduction to 20th-century art 
 
BACKGROUND INFORMATION: 
SOUTH AMERICA 
 Geometric Abstraction in South America, and introduction 
CENTRAL MERICA 
Modern Art (1880-1970) 
Mexico 
 The Mexican Revolution 
           -Mexican Muralist Painters 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
Brazil 
 The origins of modern art in Sao Paulo, an introduction 
 Neo-Concrete Manifesto 
 Lygia Clark, Bicho 
 Hélio Oiticica, Parangolés 
 Sebastião Salgado’s Kuwait 
Contemporary Art (1970-) 
Argentine 
 Marta Minujin 
Columbia 
 Doris Salcedo 
The Caribbean 
Cuba 
 Tania Bruguera, The Art of Social Change 
 Tania Bruguera, interview 
Central America 
Mexico 
 Gabriel Orozco 
 Francis Alÿs 
 Francus Alys, The Last Clown 
 
Assignments: 
Quiz 7 



Final Paper 3: By this week students must show their work to the tutor and incorporate his or her 
suggestions (please send a piece of evidence that you saw a tutor to the instructor by email). 
  
WEEK 11:  
North America in the 21st century:  
Textbook: Ch.11 
 “Art in the 21st Century,” Click Here. 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
Global Networks, Borderlands: 
Mark Lombardi, Paul Chan, Tanya Aguiñiga 
Rafael Lozanno-Hemmer, Border Tuner.” 
Postcommodity 
Transforming Public Memory 
The National Memorial for Peace and Justice. 
Social Intervention 
“Theaster Gates, PBS Newshour” “Paul Chan, Waiting for Godot in New Orleans,” “Thomas Hirschhorn, 
Gramsci Monument” 

 
WEEK 12: Q8, F4 
Art, Climate Change, and Nature 
Textbook: Ch. 11 
 
Closer Look (All “Closer Look” links are embedded in the slides):  
Olafur Eliasson Unbelievable physics in installation art, Click Here. 
Olafur Eliasson, Notion Motion 
Pierre Huyghe, Untitled (Human Mask) 
Maya Lin Ghost Forest 
Maya Lin’s Silver Upper White River 
 
Assignments: 
Quiz 8, 
Final Paper (Paper 4) 
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DISCUSSION BOARD POSTING (3%x 5) 
This assignment will fulfill Pathways’ goal of:  

• Low-stake	Writing	&	Group	Discussion:	
• Train	students	to	analyze	objects,	demonstrate	research,	evaluate	objects,	demonstrate	ability	

to	discuss	their	thoughts	reasonably,	and	convincingly.		

 
TASK 
Please follow the instructions on the syllabus. Make sure to post it on discussion board, the comment at 
lease on two peer-postings.  
 
WRITE: use free-style writing techniques. Write freely about your thoughts on the topic you are asked to 
write about. Make sure that your ideas are clear and everyone can understand it.  
 
SUBMISSION PLUS: Post your article on the discussion board, go over a few other classmate's articles, 
and comment at least once. 
 
PURPOSE: Get used to the technology and get to know other students in the classroom. Casual exercise 
to articulate your ideas and observations. 
 
AUDIENCE: Peer students 
 
Length: 1 paragraph, post it on the discussion forum  
 
FORMAT: if possible, use 12 pt Times New Roman  
  



KINGSBOROUGH COMMUNITY COLLEGE 
ART 2400-01/ Yamamura 

W-A: READING SUMMARY (5%, formal writing, due DATE) 
This assignment will fulfill Pathways’ goal of:  

• Train	students	to	analyze	the	assigned	text,	evaluate	is,	and	demonstrate	ability	to	discuss	their	
thoughts	reasonably	and	convincingly	in	writing.			

 
For each assigned text  

1) Take notes of some important points that appear in the assigned text 
2) Think, what is the central argument of this text 
3) Critically interpret and analyze their central arguments 
4) Write your reflection: whether you agree or disagree with the central arguments and why.  

 
Length: 1 pg. 
 
Audience: Academic audience.  
 
Purpose: Think that this is a book review. Inform your readers what you read and which aspects of this 
reading were interesting and why. 
 
You are writing for a well-read audience. Therefore, you must review and polish the text at least three 
times to make it an exciting reading for your readers.  
 
Formatting your paper: Times New Roman, 12-point font, double spaced with 1-inch margins and page 
numbers 
Your paper MUST BE typed. Please format your paper using the following functions. 
1. Go to: “Format” > “Document” >“Margins”: Set the margin at 1” for all sides of your paper 
2. Go to: “Format” > “Paragraph > “Indents and Spacing” > “Spacing” > “Line spacing”: Select “Double” 
3. Go to: “Font” > “Font Collections”: Select “Times New Roman”  
4. Set the font size at “12 point” 
5. Go to: “Insert” > “Page Numbers”: Select bottom center  
 
How to submit your paper? 
The submission link is in the Assignment folder.  
*DO NOT TYPE DIRECTLY. SOMETIMES, THE PAGE DOES NOT REGISTER YOUR 
WRITING. 
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FORMAL PAPER 
 

This assignment will fulfill Pathways’ goal of:  
• High-stake	Writing:	
• Train	students	to	analyze	objects,	demonstrate	research,	evaluate	objects,	demonstrate	ability	

to	discuss	their	thoughts	reasonably	and	convincingly	in	writing.		
 
PROMPT: Visit one of the contemporary art exhibitions in NYC. Some candidates are listed on the 

blackboard. For this class, understanding how artists are responding to the contemporary issues based 
on his or her experience and their particular background are very important. Please find the following 
instruction 1-4. 

 
PAPER COMPONENTS 1~4 (due dates are listed in the syllabus) 

1. Rough draft 
Visit one of the places recommended by the instructor or based on your research. Bring a notepad, 
take notes on the spot, why you are interested in the particular object, what you want to express 
by writing about this work of art—remember, writing is a self-expression! 
Ask yourself: 
1) Which postmodern strategies the artist is using? (Materials and techniques are important for 
the artist expressing him or herself!) 
2) What you think the artwork is about? 
3) How do you think this work would impact its viewers. 
 

2. Draft paper 1 
1) Go over the instructor’s response on your paper.  
2) Think about the artist’s milieu, what is he or she responding to make these artworks?  
3) Does the artist’s racial or ethnic background inform this artwork?  
4) How does artist use materials and forms to communicate with people?  
5) Think about the merits of your take on the subject 
6) Make a plan of your research, what you need to find out 
7) Discuss your research direction with the instructor, then the librarian, Mark Eaton 

  Mark.Eaton@kbcc.cuny.edu 
	 	 (718)	368-6557 

8) After reading about the artist and artwork, summarize what you read, compare them with 
your approach to the topic 

9) Use other people’s writings to tease out the merits of your text, write a thesis line, prove it 
with visual observation and research, summarize, and write your contribution to the field as 
the conclusive line 

3. Draft of your paper 2  
Work with the editor: Let’s think that the Writing Fellow is your editor. Contact the writing 
center (TBD). Show your draft after incorporated the instructor’s suggestions, work with the 
fellow, and get proof (your email communication with the tutor). Submit the proof to the 
instructor (keep working on the text). 

4. Submit the well-edited and polished copy of your essay to the instructor 

 
  



 
KINGSBOROUGH COMMUNITY COLLEGE 

ART 2400-01 
Final "Art Discussion Paper":  Grading Checklist and Point System (Rubric) 

 

Task Points for 
Task 

Cover page, Illustration, Bibliography plus 6-Page Minimum (1500 
words total) 10 points  

Written content 80 points 
1. Your title forecasts the paper direction 
2. Your essay has a clear thesis statement. 

      (5) 
     (10) 

3. You supported your thesis with firm 
arguments and backup pieces of evidence      (25) 

      4.    Is your paper easy for a reader to follow?  
• Written in clear sentences 
• Each paragraph has a function to prove the thesis line 
• You have a smooth paragraph transition  

      (20) 

      5. Conclusion:  
• Summarized all the backup arguments 
• Mention oppositional narrative 
• Convincingly explained how your argument best supports 

your thesis  

      (10) 

       6.  Grammar, spacing, capitalization, and format  
Formatting your paper: Times New Roman, 12 point font, double 
spaced, with 1-inch margins and page numbers  

(10) 

Citations and bibliography in proper Kate L. Turabian A Manual for 
Writers format  10 points 

Total: 100 points 
 
After completing the first draft, think of the following: 

• Think that each paragraph is a piece of a puzzle. Do you think the paragraphs fit in the best way 
and presenting a coherent narrative? 

o Are there parts that should be shifted or moved around? 
o Are there parts that should be added or deleted? 
o What is missing from the draft? 

• Do you think some parts of the draft need more details, explanations, and evidence? 
 
 
After completing the first draft, think of the following: 

• Think that each paragraph is a piece of a puzzle. Do you think the paragraphs fit in the best way 
and presenting a coherent narrative? 

o Are there parts that should be shifted or moved around? 
o Are there parts that should be added or deleted? 
o What is missing from the draft? 

• Do you think some parts of the draft need more details, explanations, and evidence? 
 

 
 

Review Guidelines 
 

Title: Does the title forecasts the paper direction? 
Find a thesis line in your partner's writing. 

• Do you think the thesis is supported by strong arguments and backup pieces of evidence? 



 
Body of the text: Is this paper easy for a reader to follow?  

• Written in clear sentences 
• Each paragraph has a function to prove the thesis line 
• You have a smooth paragraph transition  

 
Conclusion:  

• Summarized all the backup arguments 
• Mentioned oppositional narrative 
• Convincingly explained how your argument best supports your thesis. 

How are capitalization, spelling, and grammar of your friend?  
What would be your assessment of this writing? If it is not an A paper, can you suggest improving it, 
considering all the above elements? 
 
Formatting: Times New Roman, 12 point font, double spaced, with 1-inch margins and page numbers  
 
Citation: Did the author properly acknowledge the sources? 
See the sample paper for the example of a citation. 
 
 

 
 
 
 
 
 
  



13. SELECTED BIBLIOGRAPHY AND SOURCE MATERIALS: 
 

General Introductory Books: 
Bikers, Patricia and Andrew Wilson. Taking Art: Interviews with Artists since 1976. London: Art 

Monthly and Ridinghouse, 2007. 
Farver, Jane, Luis Camnitzer, and Rachel Weiss, eds. Global Conceptualism: Points of Origin, 

1950s-1980s. New York: queens Museum of Art, 1999. 
Hopkins, David. After Modern Art: 1945-2000. Oxford and New York: Oxford University Press, 

2000. 
Kocur Zoya and Simon Leung, eds., Theory in Contemporary Art since 1985. Malden, MA: 

Blackwell, 2005.  
Nochlin, Linda. Women, Art, and Power and Other Essays. New York: Harper & Row, 1988. 
Martin, Jean-Hubert. Magiciens de la Terre. Paris: Centre Pompidou, 1989. 
Schimmel, Paul., ed. Out of Actions: Between Performance and the Object 1949-1979. New 

York: Thames & Hudson for the Museum of Contemporary Art, Los Angeles, 1998. 
Stiles, Kristine and Peter Selz, eds. Theories and Documents of Contemporary Art; A sourcebook 

of Artists’ Writings. Berkley: University of California Press, 2nd Ed., 1996.  
 
Area Studies 
Postmodernism 
Foster, Hal., ed. The Anti-Aesthetic: Essays on Postmodern Culture. Port Townsend, WA: Bay 

Press, 1983. 
Harvey, David. The Condition of Postmodernity: An Enquiry into the Origin of Cultural Change 

(Oxford and Cambridge, MA: Blackwell, 1989. 
Lyotard, Jean-Francois. The Postmodern Condition: A Report on Knowledge. Manchester: 

Manchester University Press, and Minneapolis: University of Minnesota Press, 1984. 
 
Different Cultural Zones 
 
Camnitzer, Luis. Concptualism in Latin American Art: Dialectics of Liberation. Austin: 

University of Texas Press, 2007. 
Enwezor, Okwui, ed., The Short Century: Independence and Liberation Movements in Africa, 

1945-1994. Munich: Prestel, 2001. 
Enwezor, Okwui and Oguibe, Olu., eds. Reading the Contemporary: African Art from Theory to 

Market Place. London: Institute for International Visual Arts, 1999.  
Groys, Boris. The Total Art of Stalinism Avant-Garde, Aesthetic Dictatorship and Beyond. 

Princeton, NJ: Princeton University Press, 1992. 
Minglu, Gao., ed. Inside Out: New Chinese Art. Berkley: University of California Press, 1999. 
Munroe, Alexandra. Japanese Art After 1945: Scream Against the Sky. New York: Abrams, 1994. 
Mitter, Partha. Indian Art. Oxford: Oxford University Press, 2001.  
Poshyananda, Apinan, et. al. Contemporary Art in Asia: Traditions⁄Tensions. New York, Asia 

Society, 1996.  
Said, Edward. Orientalism. New York: Vintage Books, 1979.  
Sullivan, Edward. The Language of Objects in the Art of the Americas. New Haven: Yale 

University Press, 2007. 
Turner, Caroline., ed. Art and Social Change, Contemporary Art in Asia and the Pacific. 

Canberra: Pandanus Books, Research School of Pacific and Asian.  
 


	Closing of Degree: Off
	Closing of Certificate: Off
	New Certificate Proposal: Off
	New Degree Proposal: Off
	New Course: Off
	New 82 Course Pilot Course: Off
	Deletion of Courses: Off
	Change in Program Learning Outcomes: Off
	Other please describe: Off
	Change in Degree or Certificate: Off
	Change in Degree Adding Concentration: Off
	Change in Degree Deleting Concentration: Off
	Change in Prerequisite Corequisite andor PreCorequisite: Off
	Change in Course Designation: Off
	Change in Course Description: Off
	Change in Course Title Number Credits andor Hours: Off
	Change in Academic Policy: Off
	Pathways Submission: On
	Life and Physical Science: Off
	Math and Quantitative Reasoning: Off
	A World Cultures and Global Issues: Off
	B  US Experience in its Diversity: Off
	C  Creative Expression: On
	D  Individual and Society: Off
	E: Off
	Date Approved: 
	Date Approved_2: 
	Date Approved_3: 
	Text1:   Art
	Text2:  9/20/2021
	Text3: ART 2400 - Global Contemporary Art: Diversities and New Expressions
	Text4: 
	Text5: 
	Text6: 
	Text7: 
	Text8: 


